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OkySoft2 is the software provided with OkyWeb2 that allows you to easily use large libraries of songs and program
various OkyWeb2 functions more rapidly:

Saving an unlimited number of songs on your Hard Disk.
Transferring backing tracks to the OkyWeb2 Compact Flash card.
Programming Playlists.
Connecting to the OkyWeb2 Web site to download backing tracks from the library.
Transforming Standard MIDI Files into MF5 files.
Handling MF5 files.
Editing and transferring EQ/EFX presets.
Updating the OkyWeb2 operating system online.
Playing backing tracks saved on the PC using the PC’s MIDI player or OkyWeb2 directly.
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Installation

Minimum computer requirements
- PC Pentium II 300MHz (or equivalent)
- MS-Windows®: Win98SE/ME; 2K/XP  (or later).

N.B.: Win95 and Win98 are not supported, due to USB system compatibility limits.
- 1 free USB port (version 1.1 or later).

N.B.: USB hubs (devices able to handle several USB peripherals) can be used, providing they are powered models.
It’s advisable to avoid using passive (un-powered) hubs or USB splitters.

Easy installation
IMPORTANT: install OkySoft2 before connecting OkyWeb2 to your computer.

For problem-free installation, proceed as follows:

Click here to visit the OkyWeb2 web site and download OkySoft2 operating software
or type: http://www.okyweb.com.au/updates/setup.exe in your browser to go direct to the download screen.
When downloading the software, it is safe to ignore any warnings, including virus warnings. The alerts are standard
Windows® warnings and do not apply with authorised software.

IMPORTANT: Ensure the OkyWeb2 ‘is not’ attached to the USB port while setting up the software.
The unit is connected to the USB port after the software is installed during the second phase of installation
(Hardware Wizard)

Once downloaded, double click on SETUP.EXE.

Follow the step-by-step instructions that appear on your PC’s monitor.
At the end, you’ll be asked to reboot your computer.

After rebooting, you can start using the program.

NOTE in the “Windows Logo” test with XP
During this procedure, Windows XP® will warn that the software/driver being installed is not part of the “Windows
Logo” program.
No Problem! Proceed by clicking on Continue and complete the installation.

Updates
For its very nature, software is constantly evolving, implementing new functions or improving those already
existing.
If you have a Web connection, check periodically for the availability of updates and new releases of OkySoft2, of
the OkyWeb2 operating system and relative documentations and manuals.
You can click on the appropriate icon of OkySoft2 or visit the HitTrax/OkyWeb2 web site.

http://www.okyweb.com.au/updates/setup.exe
http://www.okyweb.com.au/updates/setup.exe
http://www.okyweb.com.au
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MULTIPORT / USB
CABLE

USB port

Connecting OkyWeb2 to a PC

IMPORTANT: install OkySoft2 before connecting OkyWeb2 to your computer.
N.B.: OkySoft2 must be installed before connecting the hardware (or enabling additional software), so that drivers and devices necessary
for the correct use of OkyWeb2 are supplied to Windows®.

After installing the software, connect the
OkyWeb2 Multiport to a USB port of your PC,
using the Multiport/USB cable provided.

Make certain OkyWeb2 is switched on and in
Stop status.
If installation procedure has been carried out
correctly, Windows® will detect the presence
of the new hardware and guide you step by
step through automatic installation of the drivers for OkyWeb2.
Should this not be the case with your system, repeat the installation.
In the event of difficulties, you can carry out a couple of alternative procedures, both from the
Windows® Control Panel:
- alternative 1): Follow “Printers and Other Hardware / Add Hardware”.

When your system prompts for software and/or drivers for the new hardware,
insert the CD-Rom provided and follow installation instructions.

- alternative 2): Follow “Performance and Maintenance / System / Hardware / Device Manager”.
Select the USB device which appears as faulty.
Right-click on it and choose to Update Driver. Choose the expert mode and set
the following path: C:\WINDOWS\system32\drivers
Then click Next and follow instructions.

NOTE in the “Windows Logo” test with XP
During this procedure, Windows XP® will warn that the software/driver being
installed is not part of the “Windows Logo” program.
No Problem! Proceed by clicking on Continue and complete the installation.

When the procedure is finished, Windows® will indicate that the new hardware is installed and ready for use.
Start OkySoft2 by clicking on the program icon on the desktop.
If everything is OK, after an initial data exchange phase, the OkySoft2 STATUS LED turns
green, showing that communication between OkySoft2 and OkyWeb2 is enabled.

Status LED
The Status LED indicates the status of communication between OkySoft2 and OkyWeb2:
green: connection available - line free
yellow: connection available - OkyWeb2 busy (e.g. song being played)
red: no connection / line not accessible
flashing red: connection available - OkyWeb2 has no Operating System

(OkyWeb2 function Tools / Update OkyWeb2 Operating System must be run).
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OkySoft2’s two windows
After the data are uploaded, the program shows:
- in the top window: the list and number of the songs available in the PC’s Download Folder;

- in the bottom window: the list and number of the songs contained in the OkyWeb2 Compact Flash card
(or in the Compact Flash card of a card drive - e.g. M-Live OkyWrite - if connected).

- on the bottom border: free memory of the Compact Flash card
the number of the song currently selected

Download Folder
The program automatically creates a Download folder in the PC’s Hard Disk, which becomes the reference folder
for transferring songs from OkyWeb2 to the PC.
To create other folders, use standard Windows procedure.
To change the folder, you can use the “Select the Download Folder” function in the File menu.
In this way, you can organize your archive of backing tracks in more than one folder (for example to have the
images of various Compact Flash cards at your disposal).

Importing songs to the Download folder

Click on the icon  corresponding to the  “Import from PC” and “Import from Floppy” functions in the File menu.

In the standard Windows® window that appears, look for the files you wish to import, then press Open.
Songs that can be imported are files in .MID (0 or 1), .KAR, .MF3 and MF5 format.
N.B.: remember that some MIDI Files on the market don’t contain text data.

N.B.: during import procedure, OkySoft2 automatically converts the files, thus making them immediately
transferable to OkyWeb2.

Importing songs is also possible using the classic Drag & Drop method. In fact, it is sufficient to select the songs
in other Windows® windows and drag them into the OkySoft2 window: the songs are automatically added to the
list of songs available on the PC’s Hard Disk (top window).
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Transferring songs between PC and Compact Flash cards
The transfer (or rather the copy) of songs between PC and Compact Flash cards is done in a very simple manner:

Transferring songs from the PC to OkyWeb2

In the Hard Disk window (top), select the
songs you want to transfer.
N.B.: to select, use customary Windows® procedure.

then:
Drag the songs into the Compact Flash card
window (bottom);

or:
in the File menu, select the “Transfer PC ->
Compact Flash” function;

or:
press the transfer key.   

Transferring songs from OkyWeb2 to PC

In the Compact Flash Card window (bottom),
select the songs you want to transfer.
N.B.: to select, use customary Windows® procedure.

then:
Drag the songs into the Hard Disk window
(top);

or:
in the File menu, select the “Transfer
CompactFlash -> PC” function;

or:
Press the transfer key.   
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Playlist

OkySoft2 enormously simplifies OkyWeb2 Playlist programming. The Playlists are displayed in the appropriate
window and it’s sufficient to drag the Titles of the songs to add or remove to/from the list or change playing order.

IMPORTANT: OkySoft2 handles the Playlists of a specific Compact Flash card, i.e. the Compact Flash card
connected to the computer by means of OkyWeb2 (or via the card drive - e.g. M-Live OkyWrite).
When creating Playlists, the program uses the Songs contained in the connected Compact Flash card.
This also means that if no Compact Flash card is connected to the computer, the Playlist function isn’t operational.
N.B.: remember that the connection of a Compact Flash card is necessary for the correct operation of OkyWeb2.
Each Compact Flash card can contain up to 16 Playlists.

Enabling the Playlist function

Click on the Playlist key  or select the “Playlist” function in the Tools menu.

The Playlist List window appears with the relative functions:

New Creates a new Playlist.
The name “New Playlist” is assigned in default by OkySoft2. It is already selected and can be
immediately edited. If you wish, key in the new name and press Enter or click anywhere on the
screen.

Open Opens the Edit window of the selected Playlist.
Select a Playlist and click Open.
A quicker method to access Playlist editing is to double click on the name.

Rename Allows to change the name of the selected Playlist.
Select a Playlist and click on Rename: the name is highlighted and becomes editable.
Key in the new name and press Enter or click anywhere on the screen.

Delete Deletes the selected Playlist.
Select a Playlist and click on Delete: a confirmation prompt allows you to confirm or annul Playlist
deletion, safeguarding you from any accidental mistakes.
N.B.: the deletion of the Playlist obviously only regards the playback list, not the songs listed in it.

Exit Exits from the Playlist function and returns to the main OkySoft2 window.
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Editing the Playlist

Selecting a Playlist and clicking on Open or double clicking on the name of a Playlist, you can access Playlist
Editing.

In the top part, the Edit window contains the list of all the Songs contained on the Card, and in the bottom part the
list of the Songs contained in the selected Playlist.

To add a Song click on the name in the top list
and drag it into the bottom window where required.

To change the position of a Song already in
the list, click on its name and drag it to the required
place.

To add a Song at the beginning of the Playlist
select it and click on Beginning. 

To add a Song at the end of the Playlist
select it and click on End.  

To delete a Song from the Playlist
select it and click on Delete.  

To exit the Playlist Edit window

Click on Exit  or simply close the window with customary Windows® procedure.
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MIDI Player

   Player Controls.

The Play and Stop keys allow to start and stop song playback, enabling you to listen to the songs contained in
the OkySoft2 Download folder, as well as those contained in the Compact Flash card.

Setting the default MIDI Player
You can choose your favourite device by means of the Tools / MIDI Player
Setting function.
As a player, you can use Windows® ’ default MIDI Player (in other words the
device that uses the sounds of your PC’s audio card or that of the MIDI
peripheral connected to it) or use OkyWeb2 directly.
Using OkyWeb2, you will obviously obtain excellent results, as you will exploit
its sound qualities and specific performance.

Clicking on Set, you can access the Windows® ’ Sounds and Audio Devices
Properties window, in which the PC’s MIDI Player can be set.

Playing back songs in MF5 format
Songs in proprietary MF5 format are complete with:

- 32 music tracks
- extra tracks for processing vocals
- dedicated sounds (i.e. specific to OkyWeb2), which can vary from song to song
- lyrics
- info
- other data and dedicated settings

Therefore, the songs in MF5 format can only be played by setting OkyWeb2
as OkySoft2’s preferred MIDI Player.

Playing a song
Select the required song.
Click on Play to start playback and Stop to stop it.
The MIDI Player’s controls are also accessible using the Tools / Play – Stop menu.
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Updating OkyWeb2’s operating system
Updating the OkyWeb2 Operating System is normally carried out via Internet and in a highly automated manner.
In fact, it’s sufficient to connect OkyWeb2 to the computer and enable the “Tools / Update OkyWeb2 Operating
System” function:

If you have an Internet connection OkySoft2 carries out connection, download and update completely
automatically, allowing you to easily obtain the most recent version
of the Operating System.
Should this not be the case with your system, you can proceed by manually
connecting to the HitTrax/OkyWeb2 web site (www.okyweb.com.au), where
you can download updates and new releases of OkySoft2, OkyWeb2 operating
system and relative documentations and manuals.

If you don’t have access to Internet you can use an Update Floppy Disk or CD.
In this case, OkySoft2 (after checking that there is no Internet
connection) suggests you search for the OKYWEB2.MHX file in
your PC: all you have to do is confirm, insert the Floppy Disk or
CD and access its contents with customary Windows® procedure.
(For example: select <Floppy Disk A:\> or <CD-Rom D:\>,
highlight the file OKYWEB2.MHX and click on <OK>).
Contact HitTrax on +613 9887 8127 (phone/fax) and we will
arrange for a CD to be sent by mail.
There is a nominal fee to cover materials and postage for this service.
Our full contact details can be found at the end of this manual.

Wait for the procedure to be completed. In the event of accidental interruption, repeat the operation.

http://www.okyweb.com.au
http://www.okyweb.com.au
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Function Bar

The various keys of the bar allow to rapidly enable the most frequently used functions.
The same functions are however available (along with others) by means of the various menus.

Import from PC
Allows to transfer songs contained in other folders of the PC to the Download Folder.
This function can also be enabled from the File / Import from PC menu.

Import from Floppy
Allows to transfer songs contained on a Floppy Disk to the Download Folder.
This function can also be enabled from the File / Import from Floppy menu.

Delete Song
Deletes the songs selected.
This function can also be enabled from the Edit / Delete Song menu.

Playlist
Allows to handle the song playlists.
This function can also be enabled from the Tools / Playlist menu.

Find
Enable a search among the available songs.
When this function is enabled, the Find window appears, by means of which you can run searches by
Title, Artist and/or Genre on the Hard Disk and the OkyWeb2 Compact Flash card.
Key in the Title, Artist or Genre to be found.
Press Enter.
Click on Next to select one song at a time, proceeding according to
the order of the results of the search.
Click on Select all to select all the songs that meet the search criteria.
This function can also be enabled from the Edit / Find menu.

Edit Info
Allows to display and edit the song’s information.
When you select this function, a window is enabled in which you can edit or enter the song’s parameters:
Title, Artist, Genre, Publisher and Composer.
Only the songs produced by M-Live and by HitTrax in the proprietary MF3 and MF5 formats contain
the information on Artist and Genre used by OkyWeb2 search functions.
In all the other MIDI Files you import into OkySoft2 folders, this information is entered manually using
the Edit Info function.
To use Files with the sophisticated OkyWeb2 search functions, Artist and Genre data must be entered.
N.B.: you can freely edit the classification, particularly that of the Genre,
to adapt it to your specific search criteria.
Moreover, the song Title can be written in its entirety. In this way, you
can also edit the names of old generation MIDI Files, which are typically
limited as far as the number of characters is concerned.
Artist and Genre parameters are set with a pull-down menu
that allow you to choose from a vast archive already saved
in OkySoft2. In this way, these parameters will always be
inserted with the same format, making search procedure
more precise and effective.
The function can also be enabled from the Edit / Edit Info
menu, or double clicking on the song’s title.

www.okyweb.com.au
Opens Windows® ’ default browser and, if a Web connection is available, automatically connects it to
the the HitTrax/OkyWeb2 web site, where you can download new OkySoft2 releases, updates for the
OkyWeb2 operating system, manuals and various documents.

http://www.hittrax.com.au/advsearch_h.asp
http://www.okyweb.com.au
http://www.okyweb.com.au
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Menu

File Menu

Print Allows to print the list of songs.
When this function is enabled, the
Windows®  “print” window appears, in which
you can choose whether to print the list of
the Download Folder or that of the Compact
Flash card.

Save Database Exports the list of songs in a format that
can be used with MS-Excel®, MS-Word®.
N.B.: the file saved is a “limited fields database” type
– with 5 fields: Index; File name; Title; Artist; Genre.
When this function is enabled, Windows® ’
“save” window appears, in which you can choose whether to export the list of the Download
Folder or that of the Compact Flash card.

Import from PC Allows to transfer songs contained on the PC’s Hard Disk to the Download Folder.

This function can also be enabled by means of the  function bar key.

Import from Floppy Allows to transfer songs contained on the PC’s Floppy Disk to the Download Folder.

This function can also be enabled by means of the  function bar key.

Transfer songs from PC to Compact Flash Copies the selected songs (in the top window)
from the Hard Disk to the Compact Flash card.

Transfer songs from Compact Flash to PC Copies the selected songs (in the bottom window)
from the Compact Flash card to the Hard Disk.

Select Download Folder Allows to set the reference folder for transferring songs from
OkyWeb2 to the PC.

Format Compact Flash Formats the Compact Flash card inserted in OkyWeb2 (or in the OkyWrite drive).
N.B.: OkyWeb2 is compatible with <CF> CompactFlashTM specifications and has been successfully
tested with a vast number of Compact Flash cards manufactured by various companies. Nevertheless,
M-Live declines all responsibility for any faulty operation or loss of data with Compact Flash cards
other than those sold with the M-Live brand.
In order to be used with OkyWeb2, Compact Flash cards must firstly be appropriately formatted.
Alternatively, use OkyFlash pre-formatted Compact Flash cards, tested and guaranteed by M-Live.
ATTENTION: when formatting is carried out, all the contents of the Compact Flash

card will be irreparably deleted !
N.B.: to avoid accidental formatting, enabling is preceded by a prompt for confirmation.

Exit Exits the program.
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Edit Menu

Find Enables a search among the songs
available.
This function can also be enabled by

means of the  function bar key.

Select all songs on PC
Simultaneously selects all the songs
contained in the Download Folder (top
window).

Select all songs not present on Compact Flash
Simultaneously selects all the songs contained in the Download Folder (top window), but
not contained in the Compact Flash card (bottom window).
In fact, this means all the songs without the sign 
In this way, you can easily select and transfer only songs not yet saved on the Compact
Flash card, avoiding duplicates.

Select all songs not present on PC
Simultaneously selects all the songs contained in the Compact Flash card (bottom window),
but not in the Download Folder (top window),
In fact, this means all the songs without the sign 
In this way, you can easily select and transfer only songs not yet saved on the Hard Disk,
avoiding duplicates.

Edit Info Allows to display and edit song information.
When you select this function, a window is enabled in which you can edit or enter the
song’s parameters: Title, Artist, Genre, Publisher and Composer.

This function can also be enabled by means of the  function bar key.

Delete Song Deletes the selected songs.

This function can also be enabled by means of the  function bar key.
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Tools Menu
Play - Stop Allows to start and stop the playback of the selected

song.
Functions can also be enabled by means of the keys

Play and Stop  

MIDI Player settings Allows to set the device used to play the
songs.
You can use Windows® ’ default MIDI
Player or OkyWeb2 directly. To play a
song in MF5 format, OkyWeb2 must be
set.

MIDI Mixer Enables the graphic editor of the MIDI Mixer, by means of which you can control the
tracks of the song selected. This is the equivalent of the OkyWeb2 EDIT function.
The editor can also be enabled by means of the toolbar key of the same name.

Microphone Equalizer Enables the graphic editor of OkyWeb2’s MIC EQ.
The editor can also be enabled by means of the toolbar key of the same name.

Microphone Echo Enables the graphic editor of OkyWeb2’s MIC ECHO.
The editor can also be enabled by means of the toolbar key of the same name.

Music Equalizer Enables the graphic editor of the EQ/3D of OkyWeb2’s MUSIC EFX.
The editor can also be enabled by means of the toolbar key of the same name.

Music Chorus Enables the graphic editor of the CHORUS/EFX2 of OkyWeb2’s MUSIC EFX.
The editor can also be enabled by means of the toolbar key of the same name.

Music Reverb Enables the graphic editor of the REVERB/EFX1 of OkyWeb2’s MUSIC EFX.
The editor can also be enabled by means of the toolbar key of the same name.

Optimize Compact Flash Allows to re-order the contents and/or correct any faults on the Compact Flash card,
which can occur after incorrect operations (for example, the removal of a Compact
Flash card during song transfer).
N.B.: OkyWeb2 is normally able to recognize any faults on a Compact Flash card and suggest its
optimization. You can however carry out this procedure when you think it is necessary: the operation
normally allows the functions of Compact Flash cards to be perfectly restored and the songs on them
completely recovered.
The length of the operation depends on the capacity of the Compact Flash card and the quantity of
data stored on it: in certain cases, several minutes may be necessary.

Playlist Allows to easily handle the Playlists of the Compact Flash card inserted in OkyWeb2
(or the card drive - e.g. M-Live OkyWrite).

This function can also be enabled by means of the  function bar key.

Update OkyWeb2 Operating System
Runs the procedure that allows you to always keep your OkyWeb2 updated after
you buy it.
N.B.: you can check which version is installed in your OkyWeb2 by reading the display when the unit
us switched on, or accessing the main page in the OPTIONS menu.
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Options Menu

OkyWeb2 Options Allows to easily set all the options of OkyWeb2’s
Option menu.

Change the parameters using the corresponding pull-down menus.
Remember that the options are saved on the Compact Flash card: they can therefore vary
from one Compact Flash card to another.
N.B.: for information on Option parameters, you can consult the OkyWeb2 manual.

OkySoft2 settings Enables a window in which you can set some of the program’s parameters.

Flash Card Drive
Sets the drive (e.g. OkyWrite) for Compact Flash cards used by the
program.
N.B.: if the drive is not indicated correctly, some faulty operation may occur with OkySoft2
or the computer.

Check new Genres / new Artists
Enables a check during the entering of data in the Edit Info window.
The program warns if the genre or artist entered is not contained in
OkySoft2’s Database.

Request connection at start-up
Automatically enables the request for a connection to the HitTrax/OkyWeb2 web site when the program
is started.

? Menu
Information on OkySoft2 Provides general information on the program and the version

currently installed.

http://www.okyweb.com.au
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Editors of the Processors and MIDI Mixer

The bar’s keys allow to rapidly enable/disable the graphic editors of the OkyWeb2 processors and MIDI Mixer.
The same functions are also available in the Tools menu.

Each key has a LED, which shows the editor status:
LED off = editor disabled
Green LED = editor enabled with processor in ON status (enabled)
Red LED = editor enabled with processor in OFF status (bypass)

N.B.: the MIDI Mixer doesn’t use this last function

I M P O R TA N T: remember that OkySoft2 graphic editors are simply remote controls.
The real processors are physically contained in OkyWeb2.
For this reason, when OkyWeb2 is not connected, the editors are disabled.

Common operating modes
Each editor obviously contains the specific control tools for the relative processor.
Nevertheless, the operating principles and control interface are identical in all the editors.
By means of the editors, you can create and manage entire custom preset libraries, which can be used with all songs.
The MIDI Mixer, on the other hand, directly changes the parameters of a specific song.

Load Preset
Allows to load a preset.
According to whether PC or OKYWEB2 is selected,
the search for the preset to upload is run in the PC’s Hard Disk
or in OkyWeb2’s Compact Flash card.
Standard Windows® operating modes are used.

The name of the preset uploaded appears in the Presets window.

Any changes to the preset after having uploaded it are indicated
by the appearance of an asterisk added to the name.

Save Preset

Allows to save a preset with the processor’s current settings.
According to whether PC or OKYWEB2 is selected,
the preset can be saved on the PC’s Hard Disk or
OkyWeb2’s Compact Flash card.
Standard Windows® operating modes are used.

The name of the saved preset appears in the Presets window.

Any changes to the preset after having uploaded it are
indicated by the appearance of an asterisk added to
the name.

ON/OFF

Allows to enable/disable the processor.
This apparently uninteresting function in fact turns out to be very useful during the procedure for fine-
tuning and perfecting the song, as it allows you to very easily carry out comparisons between the
processed and the unprocessed signal and to enable on each occasion only the required processors
for best assessing the effects.



18

  Potentiometers
Control of the various types of potentiometers (vertical and horizontal faders, rotary pots) is carried out
by clicking and keeping the mouse button pressed on the required element and dragging the mouse.
The value of the change is indicated in real time. Releasing the mouse button fixes the element’s new
value.

   Other controls
The use of other controls is quite intuitive and is carried out by clicking on arrows or other self-
explanatory indicators or clicking directly on the value shown.
For example, to change the MIDI Mixer’s Status parameter, just click on the value to change it in
PLAY, MUTE, Semi-Mute and Solo and then repeat the cycle from the beginning.

   

 
Grey elements
Elements and values shown in grey (whether they are single parameters or entire processors), are
temporarily disabled elements, so are temporarily unable to be edited.
In the processors, this disabling can depend on the ON/OFF key and in the MIDI Mixer by the fact that
the track is not used by the selected song.

   
Closing the editor
The editor can be immediately closed by clicking on the small X icon, or by clicking once again on
the relative key of the editor bar.
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MIDI MIXER

The MIDI mixer is the remote control of OkyWeb2 EDIT function and allows to immediately control all the main
parameters for playing a specific song.

To enable the MIDI Mixer:
Select the required song.
N.B.: it is necessary to select a song since, as opposed to the editors
of the various processors (which affect the effects and equalizers
realizing adjustments and presets that can be used by several songs),
the MIDI Mixer has a directly exclusive effect on the parameters of
a specific song.

Click on the Mixer button of the editor bar, or enable
the MIDI Mixer function of the Tools Menu.

For a detailed description of the individual parameters,
refer to the  “EDIT” chapter in the OkyWeb2 Manual.

As far as the MIDI Mixer is concerned, the following
particularities should be noted:

Changing the instrument of the track
Click on the name of the instrument assigned to the track.
In the window that appears, choose the required family of instruments.
If necessary, scroll the list of instruments belonging to the family, then double click on the name of the required
instrument.

          

Selecting tracks 17-32 in MF5 files
Songs in MF5 format have a series of extra data compared to MIDI standards.
Among the most outstanding characteristics are 32 MIDI tracks (compared to the 16 of normal MIDI Files).
To access editing of tracks 17-32, click on the small selection arrows.

MF5 Song MIDI Song

         

N.B.: selection of tracks 17-32 is automatically disabled for the songs that do not have a 32-track structure.

Saving changes
Press SAVE to save the changes to the selected song.

OkyWeb2 Player
The PLAY and STOP keys allow to play the song using OkyWeb2 and thus listen to the result of the editing

carried out with the MIDI Mixer.

N.B.: the MIDI Mixer’s Player only plays the songs with OkyWeb2. So, if OkyWeb2 is not connected, you can
change and save the songs contained in the PC’s Download folder, but cannot listen to results with the MIDI Mixer. You can eventually play
them by means of Windows®’ default Player, using the PLAY and STOP keys of the main window of OkySoft2. However, remember that
many parameters, effects and sounds are exclusive to OkyWeb2: therefore, using other playback systems, the results could be a lot
different and not always reliable.
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MIC ECHO

MIC ECHO is the remote control of the ECHO
dedicated to OkyWeb2’s microphone.

ECHO TYPE
Allows to choose the type of Echo:
MONO ECHO
STEREO ECHO
TRIPLE ECHO

MASTER DELAY TIME
The main delay time.
Corresponds to OkyWeb2’s EchoTIME parameter
and allows to edit the time of the effect’s Master
repetition.
In fact, it makes the Echo longer or shorter.
Slave1 and Slave2 repetition times (fractions of the
master time) Depend on the Master repetition time,
according to the following automatic table:

 Stereo Echo
3/4 M

1/2 M

0 Slave1 Slave2 Master

 Mono & Triple Echo
2/3 M

1/3 M

0 Slave1 Slave2 Master

N.B.: Slave repetitions are therefore “heard” before the Master repetition.
E.g. Master Delay Time = 120 ms

Stereo Echo: Slave1 = 60 ms; Slave2 = 90 ms
Mono and Triple Echo: Slave1 = 40 ms; Slave2 = 80 ms

DELAY LEVELS
Volumes of the repetitions.

FEEDBACK
Regeneration of the delayed signal.
In other words, sets the effect’s persistence.

L.P. FILTER
The Feedback’s low-pass filter.
Controls the cut of the high frequencies in the regenerated signal.

SYNCtoMIDI
Echo synchronization mode.
This control allows to synchronize the Echo’s repetitions with the tempo of the song being performed.
In other words, it allows to have an Echo able to “keep time” with any backing track.
This control’s setting considerably changes the effect’s behaviour.
If disabled (LED off), the values of the repetitions are set by the Master Delay Time control.
The repetitions of the Echo operate with fixed values, no matter what the tempo of the songs.
If enabled (green LED), repetitions are synchronized with the tempo of the song being performed.
The repetitions of the Echo follow the effective performance tempo of each song, including variations.

Synchronization value.
Corresponds to the OkyWeb2 SYNCto parameter and allows to indicate the value of the music
note with which the Echo’s repetitions are to be synchronized:
The note values are subject to some automatic optimisation, to avoid synchronization times that are unsuitable from a
musical point of view.

SEND
The microphone signal sent to the Echo effect.
Adjusts the amount of microphone signal sent to the effect.
N.B.: the SEND control is the exact equivalent of an effect send on a normal audio mixer and must not be confused with the volume of the
effects, which on the other hand is adjusted with the MIC EFX pot on the right-hand side of OkyWeb2.
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MIC EQ   /   MUSIC EQ

MIC EQ and MUSIC EQ are the remote controls of the
respective OkyWeb2 equalizers.
The parameters are almost identical – the only difference
is the 3D Depth control, only on Music EQ.

3D DEPTH    (only Music EQ)
Adjusts the depth of the spatialization effect on the sound
of the backing track.

EQ TYPE
Allows to choose the configuration of the equalizer:
4-BAND PARAMETRIC
4-BAND GRAPHIC
3-BAND GRAPHIC
3-BAND + MID Freq

GAIN
The Gain controls work with an amplitude of ±12dB and
allow to boost or cut the respective frequencies.
E.g.: L0W = -6dB is equivalent to halving the volume of the Low
frequencies.

FREQ
The FREQ controls of the bands establish the frequencies
affected by the respective GAIN controls.
In other words, using a FREQ control moves the frequency range that
will be adjusted with the GAINs control.

WIDTH
The WIDTH controls establish the width (in octaves) of the
frequency band affected by the respective FREQ and GAIN
controls.
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CHORUS FX

CHORUS FX is the remote control of the CHORUS
effect of OkyWeb2’s MUSIC EFX.

CHORUS TYPE
Allow to choose the type of effect from a list
corresponding to that of General MIDI CHORUS:
CHORUS 1
CHORUS 2
CHORUS 3
CHORUS 4
FEEDBACK
FLANGER
SHORT DELAY
FB DELAY

PRE-L.P.
Pre-delay low-pass filter.
Controls the cut of the high frequencies in the signal
before it is processed by the effect.
In fact, it makes the sound more or less bright.

DELAY
Delay time.
Establishes the time that the effect waits before processing the signal.

FEEDBACK
Regeneration of the signal.
Establishes the effect’s persistence.

RATE
Modulation speed.

DEPTH
Modulation depth.
In fact, controls “how much” the effect affects the sound.
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REVERB FX

REVERB FX is the remote control of the REVERB effect of
OkyWeb2’s MUSIC EFX.

REV TYPE
Allow to choose the type of effect from a list corresponding
to that of General MIDI REVERB:
ROOM 1
ROOM 2
ROOM 3
HALL 1
HALL 2
PLATE
DELAY
PAN DELAY

L.P. FILTER
Low-pass filter.
Controls the cut of the high frequencies in the signal before
it is processed by the effect.
In fact, it makes the sound more or less bright.

CHARACTER
Establishes the effect’s sound texture.

REV TIME
Reverberation time.
In fact, establishes how long the effect lasts.

FEEDBACK   (only available with Delays)
Regeneration of the signal.
Establishes the effect’s persistence.
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